## Contents

### Introduction
- What’s in this manual? ................................................................. 1  
- Symbols and conventions ............................................................ 2  
- Resources available from the Help menu .................................... 2  
- Send us your documentation comments .................................... 4  

### Chapter 1: Audit Trails overview
- How does Audit Trails work? ..................................................... 5  
- Identifying tables to audit .......................................................... 6  
- Terminology used in Audit Trails ............................................... 6  

### Chapter 2: Setup
- Installing Audit Trails ............................................................... 7  
- Granting access to Audit Trails ................................................. 8  
- Selecting tables to audit ........................................................... 9  
- Applying an audit to a table ....................................................... 9  
- Setting up table auditing ......................................................... 10  
- Removing a table from the Audited Tables list ......................... 12  
- Granting Audit Trails security access ....................................... 12  
- Import and Export .................................................................. 13  
- Windows, buttons, and functions available only to the sa user ... 13  

### Chapter 3: Audited tables upgrade
- Preparing the Audit Trails database for upgrading .................... 15  
- Upgrading an audited table .................................................... 16  

### Chapter 4: Viewing audit trails
- Viewing an audit trail ............................................................... 17  
- Creating favorites ................................................................... 17  

### Chapter 5: Audit tools
- The purpose of the Audit Tools window .................................... 21  
- Truncating an audit database .................................................... 21  
- Company database maintenance ............................................. 23
Introduction

Audit Trails for Microsoft Dynamics™ GP allows you to track changes in selected tables from any Microsoft Dynamics GP module, the Dynamics system database, or a Dexterity®-based, third-party module, to audit. Audit Trails can help verify the integrity of your data. It also helps support compliance with regulations for securing, managing and controlling business data, such as Sarbanes-Oxley and FDA 21 CFR Part 11.

Audit Trails includes the following features.

- Works with any Microsoft Dynamics GP company table or Dexterity-based, third-party table.
- Captures change history with a time, date, and User ID stamp on each event.
- Captures before-change and after-change data values.
- Allows you to view change history using the SmartView (Audit Trail) window, a query and reporting tool similar to the Microsoft Dynamics GP SmartList window.
- Allows you to export change history to Microsoft® Office Excel®.
- Allows you to specify which users can view individual audit trails.
- Captures audit trail data in a separate database to help support “closed system” requirements of regulations.

This introduction includes the following sections:

- What’s in this manual?
- Symbols and conventions
- Resources available from the Help menu
- Send us your documentation comments

What’s in this manual?

This manual contains step-by-step instructions to guide you through the installation and set up of Audit Trails, as well as instructions for using the product.

This manual assumes that you are familiar with navigation principles in Microsoft Dynamics GP and that you know how to operate the Microsoft Dynamics GP business system. It also assumes that Microsoft Dynamics GP has been installed and configured on your computer.

To make the best use of Audit Trails, you should have a working knowledge of each Microsoft Dynamics GP module that you use with Audit Trails. Audit Trails integrates with every Microsoft Dynamics GP module, the Dynamics system database, and Dexterity-based, third-party developed module. It also works with any custom developed Dexterity-based modifications.

This information is divided into the following chapters:

- Chapter 1, “Audit Trails overview,” explains how Audit Trails can be tailored to a variety of businesses. This chapter includes an overview of database auditing,
followed by examples of how Audit Trails can be used to track changes to Microsoft Dynamics GP documents. It explains the specific terminology used in Audit Trails and gives hints and templates to help you configure Audit Trails to meet specific business needs.

- **Chapter 2, “Setup,”** explains how to implement your design decisions and to set up Audit Trails for your company.

- **Chapter 3, “Audited tables upgrade,”** explains how to complete an upgrade of audited tables when a new version of Audit Trails is installed. If you’re already using Audit Trails and are upgrading to the latest version, read this chapter first.

- **Chapter 4, “Viewing audit trails,”** includes instructions for viewing audit trails using the SmartView (Audit Trail) window.

- **Chapter 5, “Audit tools,”** explains how to truncate an audit database and describes company database maintenance tools.

### Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the glossary in Help.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Light Bulb]</td>
<td>The light bulb symbol indicates helpful tips, shortcuts and suggestions.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>The warning symbol indicates situations you should be especially aware of when completing tasks.</td>
</tr>
</tbody>
</table>

This manual uses the following conventions to refer to sections, navigation and other information.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Creating a batch</strong></td>
<td>Italicized type indicates the name of a section or procedure.</td>
</tr>
<tr>
<td>File &gt;&gt; Print or File &gt; Print</td>
<td>The (&gt;&gt;) or (&gt;) symbol indicates a sequence of actions, such as selecting items from a menu or toolbar, or pressing buttons in a window. This example directs you to go to the File menu and choose Print.</td>
</tr>
<tr>
<td>TAB or ENTER</td>
<td>All capital letters indicate a key or a key sequence.</td>
</tr>
</tbody>
</table>

### Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance resources on your computer, as well as on the Web.

**Contents**

Opens the Help file for the active Microsoft Dynamics GP component, and displays the main “contents” topic. To browse a more detailed table of contents, click the Contents tab above the Help navigation pane. Items in the contents topic and tab are arranged by module. If the contents for the active component includes an “Additional Help files” topic, click the links to view separate Help files that describe additional components.
To find information in Help by using the index or full-text search, click the appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. Click Add.

**Index**
Opens the Help file for the active Microsoft Dynamics GP component, with the Index tab active. To find information about a window that’s not currently displayed, type the name of the window, and click Display.

**About this window**
Displays overview information about the current window. To view related topics and descriptions of the fields, buttons, and menus for the window, choose the appropriate link in the topic. You also can press F1 to display Help about the current window.

**Lookup**
Opens a lookup window, if a window that you are viewing has a lookup window. For example, if the Checkbook Maintenance window is open, you can choose this item to open the Checkbooks lookup window.

**Show Required Fields**
Highlights fields that are required to have entries. Required fields must contain information before you can save the record and close the window. You can change the font color and style used to highlight required fields. On the Microsoft Dynamics GP menu, choose User Preferences, and then choose Display.

**Printable Manuals**
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or view.

**Orientation Training**
Accesses online tutorials that show you how to complete basic procedures within Microsoft Dynamics GP. Additional tutorials are available through the CustomerSource Web site.

**What’s New**
Provides information about enhancements that were added to Microsoft Dynamics GP since the last major release.

**Microsoft Dynamics GP Online**
Opens a Web page that provides links to a variety of Web-based user assistance resources. Access to some items requires registration for a paid support plan.

**Customer Feedback Options**
Provides information about how you can join the Customer Experience Improvement Program to improve the quality, reliability, and performance of Microsoft software and services.
Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP documentation. If you have specific suggestions or find any errors in this manual, send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation Feedback link, which is located at the bottom of each Help topic.

*Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use them freely.*
Chapter 1: Audit Trails overview

This chapter presents an overview of how to configure Audit Trails. The chapter provides details on the SmartView (Audit Trail) window and shares common examples of using Audit Trails. Information is divided into the following sections:

- How does Audit Trails work?
- Identifying tables to audit
- Terminology used in Audit Trails

How does Audit Trails work?

Audit Trails captures a snapshot of a Microsoft Dynamics GP document every time a change is made, then makes a record of the time, date and User ID associated with the change. It also captures the before-change data values and the after-change data values associated with the change.

When an audit trail is attached to a table within Microsoft Dynamics GP, the following changes occur:

- An audit table is created in the audit database that duplicates the table you are auditing. Audit Trails adds fields to each table with time, date and user ID information related to the change.
- Triggers are added to the audited tables. When a change occurs to an audited table, the triggers pass the change information to the audit database.

For example, an Inventory table might contain the following columns:

- Item number
- Item description
- Cost

A record in that table includes the following information.

<table>
<thead>
<tr>
<th>Item</th>
<th>Item description</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>100XLG</td>
<td>Green phone</td>
<td>$55.00</td>
</tr>
</tbody>
</table>

Immediately after applying the audit, the audit table includes the following information. (The time also is included in the audit database, although it’s not shown in the illustration.)

<table>
<thead>
<tr>
<th>Item number</th>
<th>Item description</th>
<th>Cost</th>
<th>Time/Date</th>
<th>User ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>100XLG</td>
<td>Green phone</td>
<td>$55.00</td>
<td>01/02/2009</td>
<td>sa</td>
</tr>
</tbody>
</table>

If a user changes the cost of the item, this is reflected in the audit database and the SmartView (Audit Trail) window includes the following information.
Identifying tables to audit

A single window, such as the Item Maintenance window, creates a single record in the Microsoft Dynamics GP database that can be thought of as a document. For some records, a change can be stored in one or more tables in the Microsoft Dynamics GP database. For example, a sales transaction has two main tables, the Sales Order Header table and the Sales Order Details table.

Creating and activating an audit requires an understanding of the Microsoft Dynamics GP database and tables, and knowledge of which tables are used to store the data that you want to audit. A good approach is to use Audit Trails in a test environment prior to activating Audit Trails in your live Microsoft Dynamics GP environment.

The Resource Descriptions is a valuable resource for identifying tables in Microsoft Dynamics GP and is provided with the product. The Window Descriptions window (Microsoft Dynamics GP menu >> Tools >> Resource Descriptions >> Windows) provides information about which tables a Microsoft Dynamics GP window uses. With that information and some testing, you will be able to verify which set of tables should be audited to meet your business’s needs.

Almost any table can be audited. The only exceptions are memory tables, temporary tables and tables with text fields.

Terminology used in Audit Trails

Audit Trails The name Audit Trails refers to the Audit Trails feature. An audit trail is also the term used to describe the document record that traces an accounting action, such the entry of a transaction, from its posted entry in a ledger back to its source in a subledger or as a journal entry in General Ledger.

Audit State An audit state indicates the current status of a table as either Audited or Not Audited.

Fields The term, fields, in Audit Trails refers to table columns.

Favorite A favorite in Audit Trails is a restricted view of an audit table according to rules that are important to your user(s).
Chapter 2: Setup

This chapter covers the process of applying an audit. Information is divided into the following sections:

- Installing Audit Trails
- Granting access to Audit Trails
- Selecting tables to audit
- Applying an audit to a table
- Setting up table auditing
- Removing a table from the Audited Tables list
- Granting Audit Trails security access
- Import and Export
- Windows, buttons, and functions available only to the sa user

Installing Audit Trails

After you install Microsoft Dynamics GP, you must complete an additional installation step to prepare Audit Trails for use.

To install Audit Trails
1. Open the Audit Trails installation window.
   (Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Audit Trails)

2. Click Install to start the Audit Trails install wizard.

3. Enter a name for the audit database.
4. Click Create to create the audit database.

   **Important Note**: If the audit database can’t be created automatically, the field under Manually created audit database? becomes editable and a message indicates that the database should be manually created on the Microsoft SQL Server™. Refer to the Microsoft SQL Server documentation for instructions for manually creating a database. Once the database has been created, return to the Audit Trails Installation window, select Yes from the drop-down list and click Next.

5. Click OK to close the Install Audit Trails window.

6. In the next window, click Install to create all the resources for this product. Each process runs automatically and the options are automatically marked as each process is completed. These processes may take several minutes to complete.

   **Important Note**: During the installation, progress is shown as each option is automatically marked. No action is required during this process. After all the installation steps are complete, click Finish to close the window.

**Granting access to Audit Trails**

During installation, the ATROLE security role was created with the ATMAINTENANCE security task assigned to it. To provide access to Audit Trails windows, you must add the users that will be working with Audit Trails to the ATROLE security role. Some windows, buttons and functions are available only to SA user. See Windows, buttons, and functions available only to the sa user on page 13 for more information.


2. Enter or select a user that works with Audit Trails.

3. Select a company in which the selected user should have access to Audit Trails.

4. Select the ATROLE security role.

5. Click Save.
Selecting tables to audit

Audit trails are set up on a per company basis; you must have a separate audit database for each audited company.

To select tables to audit:
1. Open the Audit Trail Maintenance window. (Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Audit Trails >> Audit Trail Maintenance).

This window displays the list of tables you are currently auditing, as well as tables that have been selected but do not yet have an audit applied.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon1.png" alt="Icon" /></td>
<td>Indicates tables that are added but not yet audited.</td>
</tr>
<tr>
<td><img src="icon2.png" alt="Icon" /></td>
<td>Indicates tables that are added and audited.</td>
</tr>
</tbody>
</table>

2. Click the Refresh button to display a list of Microsoft Dynamics GP tables and the tables used by integrating products. This fills in the Company Tables window on the left.

3. Select a table to audit and click Add.

Applying an audit to a table

This procedure describes the process of applying an audit to the Item Master table. The same process can be used to apply an audit to any table in an audit database.

To apply an audit to a table:
1. Open the Audit Maintenance window. (Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Audit Trails >> Audit Trail Maintenance)

2. In the Company Tables list, expand the module by clicking the plus sign in the Company table treeview.

3. Expand the Series that contains the tables to audit.
This view shows all the tables in the selected Series in alphabetical order by the table’s display name. In Microsoft Dynamics GP each table has three names:

- Display name (Item Master)
- Technical name (IV_Item_MSTR)
- Physical name (IV00101)

Instead of scrolling through the list, you can click in the window and start typing the first letter of the table’s Display Name that you’re looking for. The window scrolls to the first selection that matches the letters typed.

4. Locate the table to audit. In this procedure, the Item Master table has been selected as an example, and the Fields window, the upper right part of the window displays the fields in that table.

5. Select the table to audit. Add it to the list of Audit Tables and choose Add. The Item Master table appears in the Audited Tables pane and the status icon indicates that is ready to have the audit applied.

6. Click Apply Auditing. A message appears to verify your action. Click OK to audit the selected table. An icon indicating that the table is added and audited will appear next to the SQL Table Name.

**Setting up table auditing**

Use the Table Auditing Setup window to specify auditing options for specific tables. This window opens when you apply an audit to a table. The following procedure uses the Item Master table illustrate the process of specifying auditing options. The steps are similar for other tables.

The status indicator changes for the table when the audit has been activated. The process of activating audits on tables might take several minutes. You can audit additional tables at any time, as well as modifying the auditing options of tables that are currently being audited. When auditing options change, a backup of the old table is created and the structure of the table in the audit database also changes to reflect the new settings.
**To set up table auditing:**

1. Open the Table Auditing Setup window.
   (Microsoft Dynamics GP menu >> Tools >> Company >> Audit Trails >> Audit Trails Maintenance >> Auditing Options button)

2. Select the Item Master table from the list of Audited Tables.

3. Select Audit Options.

4. Select auditing settings for Item Master Table. The following options are available.
   - Audit Insert on Table
   - Audit Update on Table
   - Audit Delete on Table
   - Don’t track blanks on insert.

5. Select the fields to audit. All fields in the table are marked for audit by default. You must select at least one field for auditing.

6. Click the field to set a specific auditing condition for.

7. Click the Field Condition button or the Field Condition Zoom button.

8. Select a Condition Operator and Target Value in order to meet the desired condition for auditing that specific field.

   Two fields are displayed for the Between operator; one for lower and one for upper bound target values.
9. Click OK. The Condition Setup window closes and the condition is displayed in the Field Condition field as a T-SQL query.

10. Click Save when the audit setup is finished.

**Removing a table from the Audited Tables list**

Use the Audited Tables window to remove a table from the Audited Tables list.

**To remove an audit from a table:**
1. Open the Audited Tables window.
   (Microsoft Dynamics GP menu >> Tools >> Company >> Audit Trails >> Audit Trails Maintenance)
2. Select a table in the Audit Tables list.
3. If the table has an audit applied to it, click the Stop Auditing button. If the table doesn’t have an audit applied to it, skip this step.
4. Click the Remove button.

**Granting Audit Trails security access**

Audit Trails’ security access must be granted to a table before a table will be visible to a user in the SmartView (Audit Trail) window. Before using this window, users should have been granted access to Audit Trails windows. See [Granting access to Audit Trails](#) on page 8 for more information.

**To grant Audit Trails security access:**
1. Open the Audit Trails Maintenance window.
   (Microsoft Dynamics GP menu >> Tools >> Company >> Audit Trails >> Audit Trails Maintenance)
2. Choose the Access button in the Audit Trail Maintenance window.
3. Select an audited table in the Table Access window to grant user access.
5. In the Security Role pane, choose the Lookup button. In the Security Role pane, choose the lookup button to open the Security Role window.
6. Select ATROLE to grant security access to the SmartView window for this table. Choose the Select button to close the window.

7. Click on OK on the Table Access window to complete and close the process. All users that are added to the ATROLE security role now have access to this table.

Access to an audited table can also be granted to security tasks. To do so, select by Security Task in step 4 and choose ATMAINTENANCE in the Security Task pane. Refer to System Setup Guide for more information about security tasks.

Import and Export

You can import or export an audited tables list by clicking the Import and Export button in the Audit Trails Maintenance window. The import and export functions are useful for saving a list of all audited tables, for making and restoring backups, and for upgrading to a new version of Microsoft Dynamics GP. The import function imports an audited tables list. Users can use that list to easily restore a list of previously exported audited tables.

Windows, buttons, and functions available only to the sa user

This section provides information on windows, buttons and functions which are available only to the sa user.

The following buttons are available only to the sa user on the Audit Trails Maintenance window:

- Remove button
- Apply Auditing button
- Stop Auditing button
- Access button

The table Setup window is accessible to a non-sa user, but only in read-only mode. Only an SA user can change any option on this window.

The Field Condition Setup window is accessible to a non sa user, but only in read-only mode. Only the sa user can change any option on this window.

Audit Tools and Audit Tables upgrade functions are accessible only to sa user.
Chapter 3: Audited tables upgrade

This portion of the documentation describes how to perform an upgrade of audited tables when a new version of a Microsoft Dynamics GP module which contains an audited table is installed. The information is divided into the following sections:

- Preparing the Audit Trails database for upgrading
- Upgrading an audited table

Preparing the Audit Trails database for upgrading

Upgrading the Audit Trails database in its strictest sense is straightforward. However, to complete upgrade process for Audit Trails as efficiently as possible, we recommend completing the following steps before using the Audited Tables Upgrade window.

To prepare the Audit Trails database for upgrading:

1. Open the Audit Trails Maintenance window.
   (Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Audit Trails >> Audit Trail Maintenance)

2. Export the list of audited tables before installing the newer version of Microsoft Dynamics GP.

3. Export all the tables in the audit database.
   
   Be sure to export the tables from the previous version, and then import them to the new version. Do not to use the backup and restore database operation because the restore operation will overwrite the stored procedures of the newer version.

4. Install the new version of Microsoft Dynamics GP and Audit Trails.

5. Import all tables from the old audit database to the new audit database.

6. From the Audit trails Maintenance window, import the list of audited tables that you created in step 1.

7. Use the Audited Tables Upgrade window to upgrade the Audit Trails database. See Upgrading an audited table on page 16 for specific steps.
8. Set audit options for every table, even if all columns are audited.

**Upgrading an audited table**

Use the Audited Tables Upgrade window to upgrade audited tables for a company after installing a new version of Microsoft Dynamics GP. This process updates the Audit Trails databases so that it matches the changes that have been made in the updated Microsoft Dynamics GP database. The Audited Tables Upgrade window lists products whose tables are being audited and allows you to select specific tables to upgrade when moving from one version to another.

**To upgrade an audited table:**

1. Open the Audited Tables Upgrade window.  
   (Microsoft Dynamics GP menu >> Maintenance Audit Trails >> Audited Trails Upgrade)

2. Select a product which has tables that you want to upgrade and click Insert. A list of audited tables from that particular product will fill in the right scrolling window.

   Use the All button to add all audited tables and the Remove All button to remove all tables from the scrolling window. We recommend upgrading all tables to ensure that any tables that have changed in the new version of Microsoft Dynamics GP are upgraded in the Audit Trails database.

3. Review the list of tables to upgrade. All the tables are selected by default. Use the Mark All and Unmark All buttons to select or unmark all tables related to a specific product.

4. Click Upgrade.
Chapter 4: Viewing audit trails

This portion of the documentation describes how to view audit information. The information is divided into the following sections:

- Viewing an audit trail
- Creating favorites

Viewing an audit trail

Audit information is viewed by accessing the SmartView (Audit Trail) window, a query tool similar to Microsoft Dynamics GP SmartList. To open the SmartView (Audit Trail) window, click the View button in the Audit Trail Maintenance window. This procedure describes the process of applying an audit to the Item Master table. A similar process is used to apply an audit to any table in an audit database.

Each audited table appears as a folder in the left-pane. Each audited table has a default view which displays audit information.

Creating favorites

Creating a favorite allows you to store a restricted view of an audit table according to rules that are important to your organization. Favorites are set up according to your rules, and then saved for future use. The following steps are used to create and save favorite views:

To create a favorite:

1. Open the Audit Trails Maintenance window.
   (Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Audit Trails >> Audit Trails Maintenance >> Search button)
2. Click Search to open the search window.

3. Select the field to search.

4. Double-click the field name, or select it and click OK.

5. Select the operator type.

6. Enter the value that you’re searching for.

If the search is run for certain Audit_Log_Type values, adhere to the rules in the following table.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>Initial</td>
</tr>
<tr>
<td>I</td>
<td>Insert or update</td>
</tr>
<tr>
<td>D</td>
<td>Delete</td>
</tr>
<tr>
<td>i</td>
<td>Insert</td>
</tr>
<tr>
<td>u</td>
<td>Update</td>
</tr>
<tr>
<td>U</td>
<td>Upgrade</td>
</tr>
<tr>
<td>C</td>
<td>Changed list of audited fields</td>
</tr>
</tbody>
</table>

7. Click OK. This returns you to the SmartView (Audit Trail) window.

8. Click Favorites.

9. Enter a name for the search you defined.

10. Click Add. This returns you to the SmartView (Audit Trail) window.
11. Expand the table, select the report, and click Refresh.

To modify an existing favorite, repeat steps 2 through 8 and click Modify in the Favorites window.
Chapter 5: Audit tools

This portion of the documentation describes how to use the Audit Tools window. The information is divided into following sections:

- The purpose of the Audit Tools window
- Truncating an audit database
- Company database maintenance

The purpose of the Audit Tools window

The Audit Tools window provides access to two audit tools; Truncate audit database and Company database maintenance. Both tools complete important operations that help maintain your audit databases and that help to keep the performance of your Microsoft Dynamics GP system optimized.

Truncating an audit database

Use the Truncate audit database function to delete all data from the Audit Trails tables.

To truncate an audit database:

1. Open the Audit Tools window.
   (Microsoft Dynamics GP menu >> Maintenance >> Audit Trails >> Audit Tools)

2. Select Truncate Audit Database and click Next. The second Truncate Audit window opens where you must enter a comment before starting the truncate process.
3. Click the Start button. The third Truncate Audit window opens where you can verify the company database and backup files.

To confirm that you have the latest backup of the Company and Audit databases, be sure that you back up the Company and Audit databases before selecting the options next to their names and clicking Next. Select the option next to the Company and Audit database names and click Next. The fourth Truncate Audit window opens.

4. Click the Start button to start the Truncate Audit Tables process. After this process is completed, the last Truncate Audit window opens.

5. Click Finish to close the window.
Company database maintenance

Use company database maintenance to disable Audit Trails during company database activities that may create a high transaction volume that you do not want to audit. Also use this tool to turn off the Audit Trails prior to an upgrade.

This process will:

- Record a start date and time stamp.
- Remove all Audit Trails database triggers.
- Reapply the audit triggers.
- Record an end date and time stamp.

You can enter and post transactions don’t need to be audited between the time of Audit Trails database triggers are removed and then reapplied.

To complete company database maintenance:
1. Open the window:
   (Microsoft Dynamics GP menu >> Maintenance >> Audit Trails >> Audit Tools)
2. Select Company database maintenance and click Next.
3. Click the Stop button to turn off Audit Trails. To turn Audit Trails on again, follow the same procedure, click Start instead of Stop.

Click the Start button to enable Audit Trails.